DIFFERENCES IN ARCH INDEX, REARFOOT PLANTAR PRESSURE, AND FOREFOOT DEVIATION FROM CENTER OF FORCE TRAJECTORY IN THOSE WITH CHRONIC ANKLE INSTABILITY, NO HISTORY OF LATERAL ANKLE SPRAIN, AND COPERS.

Lauren Vincent, LAT, ATC

Submitted to the faculty of the University Graduate School in partial fulfillment of the requirements for the degree Master of Science in Kinesiology in the Department of Kinesiology of, Indiana University
May 2014
Accepted by the Graduate Faculty, Indiana University, in partial fulfillment of the requirements for the degree of Master of Science in Kinesiology.

Dr. Carrie Docherty, Ph.D., ATC, FNATA

Dr. John Schrader, HSD, ATC

Jackie J. Kingma, DPT, ATC, PT, PA

Date of Oral Examination
May 2nd 2014
DEDICATION

I would like to dedicate this thesis to my parents John and Sharron Vincent, and my family, Matt and Vanessa, Erin and Wes, and Lindsay, for all of their love, support, and continuous encouragement throughout this process.
ACKNOWLEDGEMENTS

I would like to thank my thesis committee, Dr. John Schrader and Dr. Jackie Kingma, for their help, time involved, and many words of wisdom during this process. Thank you to my doctoral student mentor, Emily Hall, for helping me to explore potential areas for my research. Most of all I would like to thank my thesis advisor, Dr. Carrie Docherty, for her guidance, patience, and tough-love when I needed it most throughout this endeavor. Thank you for your never-ending encouragement.
ABSTRACT

The purpose of this study was to investigate differences in arch index, rearfoot plantar pressure, and forefoot deviation from center of force trajectory in those with chronic ankle instability, copers, and no history of lateral ankle sprain. A total of fifty-seven subjects from the local community volunteered for this study. There were 20 subjects in the CAI group (age, 20 ± 3 years; height, 173.61 ± 7.84 cm; mass, 73.91 ± 17.58 kg), 20 subjects in the control group (age, 20 ± 1 years; height, 169.90 ± 9.50 cm; mass, 64.53 ± 14.01 kg), and 17 subjects in the copers group (age, 20 ± 2 years; height, 171.34 ± 7.75 cm; mass, 71.18 ± 13.00 kg). Each subject completed one session of testing in which they walked barefoot across pressure mats at a self-selected speed. The composite footprint of each trial was then divided into rearfoot, midfoot, and forefoot for arch index (foot contact area), medial and lateral rearfoot for medial/lateral rearfoot pressure ratios, and then center of force trajectory deviation from a bisection line in the forefoot. The mean of three trials was used for statistical analysis. Each dependent variable (arch index, medial/lateral rearfoot pressure ratio, and forefoot deviation of center of force trajectory) was analyzed through separate 1-way ANOVA, with 1 between-subject factor (CAI, copers, and control) and a Chi-square Test of Independence. Alpha was set at p < .05. For arch index, a one-way ANOVA yielded no significant differences between the three groups (F2,54 = 0.26, p = 0.77, \( \eta^2_p = 0.01 \), power = 0.09). A Chi-Square test of independence was calculated comparing the categorical foot types between the three groups, which showed no significant differences (\( \chi^2(4) = 6.59 \), p = 0.16). For rearfoot medial/lateral pressure ratio, a one-way ANOVA yielded no significant differences between the three groups (F2,54 = 0.69, p = 0.50, \( \eta^2_p = 0.03 \), power = 0.16). A Chi-Square test of independence was calculated comparing the
categories of medial versus lateral rearfoot pressure between the three groups, which showed no significant difference ($\chi^2(2) = 4.80, p = 0.09$). For maximal forefoot deviation from center of force trajectory, a one-way ANOVA yielded no significant differences between the three groups ($F_{2,54} = 1.19, p = 0.31, \eta^2_p = 0.04, \text{power} = 0.25$). A Chi-Square test of independence was calculated comparing the categories of medial versus lateral rearfoot pressure between the three groups, which revealed no significant difference ($\chi^2(4) = 2.77, p = 0.60$). These results of the statistical analysis revealed no significant differences between the three groups in regards to arch index, medial/lateral rearfoot pressure, or forefoot deviation from center of force trajectory. Since these dependent variables may not contribute to the development of chronic ankle instability, other factors such as proprioceptive deficits and neuromuscular differences may play a greater role. Therefore, clinicians should work on improving proprioception and strengthening of the ankle joint rather than focusing on foot type or locations of plantar pressure.
TABLE OF CONTENTS

DEDICATION .......................................................................................iii
ACKNOWLEDGEMENTS .......................................................................iv
ABSTRACT ..............................................................................................v
TABLE OF CONTENTS ........................................................................vii
MANUSCRIPT ......................................................................................1

INTRODUCTION ..................................................................................1

METHODS ..........................................................................................3

RESULTS ..............................................................................................6

DISCUSSION ......................................................................................7

REFERENCES ....................................................................................11

TABLES .............................................................................................13

LEGENDS OF FIGURES ........................................................................19

FIGURES ...........................................................................................20

APPENDIX A .....................................................................................25

Operational Definitions .................................................................26
Assumptions .....................................................................................27
Delimitations and Limitations ......................................................28
Statement of the Problem .............................................................29
Variables ..........................................................................................30
Hypothesis .........................................................................................30

APPENDIX B – Review of Literature .............................................34

APPENDIX C – Data Procedures Checklist ....................................56

APPENDIX D – Data Collection Forms and Surveys .....................61

APPENDIX E – Power Analysis ......................................................66
INTRODUCTION

Ankle sprains are one of the most common injuries in sport-related activities, with 75% of ankle injuries being ankle ligament injuries and 85% of ankle sprains occurring by inversion trauma. Some individuals who sustain a lateral ankle sprain respond well to conservative treatment and return to normal activity without any recurrent symptoms or episodes of instability. These individuals are often referred to as copers. However, others may experience residual symptoms, including pain, crepitus, weakness, stiffness, recurrent sprains, and instability. These individuals are classified as having chronic ankle instability. Chronic ankle instability (CAI) is a term used to describe the perceived awareness of the ankle to “give way” or to be weak and unstable.

To better understand why lateral ankle sprains occur, many researchers have looked at both extrinsic and intrinsic risk factors that may predispose someone to an ankle injury. Examples of extrinsic risk factors are level of play, exercise load, amount and extent of training, position played, equipment, playing field conditions, rules, foul play, and others that are environmentally-related items. These extrinsic factors might be more difficult for clinicians to prevent, but the intrinsic risk factors, which include patient demographics, ligamentous stability, postural sway, muscular strength, gait mechanics, muscle reaction time, and anatomic foot and ankle alignment might be items that once identified, a healthcare practitioner can manipulate in an attempt to prevent future injuries from occurring.

Foot posture is one aspect of evaluating anatomic foot and ankle alignment. Generally, the foot can be separated into three main classifications which include: pes cavus (high-arched), pes rectus (normal), and pes planus (flat foot). Some researchers have reported a correlation between people with ankle instability and the presence of cavovarus deformity of the foot and
ankle complex.\textsuperscript{19-21} Cavovarus deformity is defined as the combination of rearfoot varus, pes cavus, and excessive plantarflexion of the first ray.\textsuperscript{22} One method that was first developed and used by Cavanagh and Rogers\textsuperscript{23} as an indirect method of measuring foot type is the arch index\textsuperscript{23-29}. It represents the ratio of the area of the middle third of a footprint relative to the total area excluding the toes. According to Cavanagh and Rogers\textsuperscript{23} a low arch index (flatter foot) is $\geq 0.26$, a normal arch index is $0.22-0.25$, and a high arch index (high arch) is $\leq 0.21$.\textsuperscript{23,27}

A few studies have looked at the relationship between dynamic plantar pressure and ankle instability.\textsuperscript{30-36} Each of these three studies found a more laterally deviated foot pattern in those with ankle instability compared to the control group.\textsuperscript{30-36} Center of force trajectory displays the movement of the center for all the forces on the pressure mat. It is stated that because of this greater supination (laterally deviated foot pattern) in the stance phase\textsuperscript{30} and a more laterally deviated center of force,\textsuperscript{32} the ankles of those with functional instability are placed in a more compromised position for recurrent sprains.\textsuperscript{30,32}

This investigation will focus specifically on arch index, and foot posture, in the form of peak plantar pressure, which has been previously examined in those with ankle instability. Researchers have identified that subjects with ankle instability have more lateral center of pressure and greater plantar pressure on the outside of their foot throughout the gait cycle compared to control participants.\textsuperscript{30-36} Because of this laterally-deviated stance phase, the ankle is put in a more compromised position for recurrent ankle sprains or chronic instability. Peak plantar pressure is an indirect measurement of foot posture and can be a useful tool to differentiate between those with chronic ankle instability and those without a history of lateral ankle sprains.
Following a lateral ankle sprain, it is not understood why some patients experience residual symptoms resulting in recurrent instability, while others go on to function without any impairments (copers). Deviations in foot and ankle alignment and discrepancies in how the foot articulates with the ground during ambulation are potential explanations for these differences. Therefore, the purpose of this study is to characterize differences in arch index, rearfoot plantar pressure, and forefoot deviation from center of force trajectory in those with CAI, copers, and no history of ankle sprain.

**METHODS**

**Subjects**

A total of fifty-seven subjects from the local community volunteered for this study. For all groups, subjects were 18 years or older and were physically active individuals, classified as being involved in activity at least 3 times a week for a minimum of 30 minutes per session. Subjects had no acute or symptomatic lower extremity injuries within the last 3 months and displayed no symptoms of swelling, discoloration, or pain. Also, subjects had no history of lower extremity surgeries or fractures. There were 20 subjects in the CAI group (age, 20 ± 3 years; height, 173.61 ± 7.84 cm; mass, 73.91 ± 17.58 kg), 20 subjects in the control group (age, 20 ± 1 years; height, 169.90 ± 9.50 cm; mass, 64.53 ± 14.01 kg), and 17 subjects in the copers group (age, 20 ± 2 years; height, 171.34 ± 7.75 cm; mass, 71.18 ± 13.00 kg). The subjects in the CAI group reported a history of lateral ankle sprains, frequent “giving way” referring to at least 2 episodes of their ankle “giving way” in the past 12 months, and a score of 11 or higher on the IdFAI questionnaire. Subjects in the copers group had a history of one lateral ankle sprain occurring greater than 12 months prior to the study, however, they had never experienced any episodes of their ankle “giving way” or other residual symptoms. The subjects in the control group had no history of ankle sprains, no current episodes of “giving way” and a score of 0 on
the IdFAI. Before participating in this study, all subjects read and signed an informed consent form approved by the University Institutional Review Board for the Protection of Human Subjects, which also approved the study.

**Procedures**

The three dependent variables of this study that were measured include the arch index, rearfoot medial/lateral pressure ratio at initial peak ground reaction force, and maximal forefoot deviation of center of force trajectory. These were obtained by having each subject walk barefoot across two Tekscan pressure mats (HR Mat Research, Tekscan, Inc., South Boston, MA). The pressure mats were placed sequentially in the middle of a 13-m walkway. Data were collected for ten seconds at a sampling rate of 40 frames per second.

Subjects walked across both pressure mats at a self-selected speed, completing a step on each mat (Figure 1b). An acceptable trial included total foot contact recorded on both pressure mats with no observable alteration of gait, which could include “stutter stepping” before the pressure mats or lengthening/shortening their gait cycle in order to step on the pressure mats. Subjects were instructed to look straight ahead at the wall and not at the ground. Five to seven practice trials were allowed until the subject felt comfortable with the procedure. The average of three successful trials was used for statistical analysis.

**Data Processing**

**Arch index**

Arch index was measured using the contact area of a composite footprint. This is the same procedure as described by Cavanagh and Rogers, Wearing et al, and Yalcin et al. Arch index is defined as the ratio of the area of the middle third of the footprint relative to the total area excluding the toes. Arch index is calculated as $[M/(H+M+F)]$ where $M=midfoot$
area, H=hindfoot area, and F=forefoot area. Initially, foot contact area was determined in order to calculate arch index per footprint. Each composite footprint per trial was divided into hindfoot, midfoot, and forefoot for processing to determine the arch index. Through the software options of property analysis within the boxes, the total contact area was calculated for each box (Figures 2a). The total contact area from each of the three boxes was entered into Excel for data processing and comparison across the three trials for each condition. Using the previously mentioned equation, the arch index was calculated for each foot of each subject. A low arch index (flatter foot) is ≥0.26, a normal arch index is 0.22-0.25, and a high arch index (high arch) is ≤0.21.23,27

**Rearfoot medial/lateral pressure ratio at initial peak ground reaction force**

The rearfoot pressure ratios were measured similarly as described by Morrison et al.35 The foot composite was bisected into medial and lateral sections by a line drawn from the space between the second and third metatarsal and the midpoint of the posterior calcaneus.35 Then boxes were drawn over the medial and lateral rearfoot sections. A force vs time graph was created to show the ground reaction forces throughout the stance phase of walking. The peak plantar pressure was determined for each box at the moment of initial peak ground reaction force (the first peak wave) from the graph (Figure 3). Then the medial value was divided by the lateral value. Ratios > 1.0 indicated a greater medial pressure, and < 1.0 indicated a greater lateral pressure.35

**Maximal forefoot deviation of center of force trajectory**

A composite footprint displaying peak stance and center of force (COF) trajectory was used to measure this dependent variable. Peak stance refers to the maximal amount of pressure created under the foot at any point throughout the stance phase of gait. Center of force trajectory
displays the movement of the center for all the forces on the pressure mat. The foot was bisected into medial and lateral sections by a line drawn from the space between the second and third metatarsal and the midpoint of the posterior calcaneus. The maximal deviation in the forefoot from the bisection line to the COF line was measured in centimeters. A positive value reflects a lateral deviation while a negative value reflects a medial deviation.

**Statistical Analysis**

Each dependent variable was analyzed separately using an ANOVA, with 1 between-subject factor (FAI, copers, and control). Categorical data for each dependent variable was analyzed separately using Chi-square Test of Independence. Alpha level was set at $p<0.05$.

**RESULTS**

**Arch Index**

A one-way ANOVA conducted on the data yielded no significant differences in arch index between the three groups ($F_{2,54} = 0.26, p = 0.77, \eta_p^2 = 0.01, \text{power} = 0.09$). A Chi-Square test of independence was also calculated comparing the categorical foot types between the three groups, which showed no significant difference ($\chi^2(4) = 6.59, p = 0.16$).

**Rearfoot Medial/Lateral Pressure Ratio**

A one-way ANOVA conducted on the data yielded no significant differences in rearfoot medial-to-lateral pressure ratios between the three groups ($F_{2,54} = 0.69, p = 0.50, \eta_p^2 = 0.03, \text{power} = 0.16$). A Chi-Square test of independence was also calculated comparing the categories of medial versus lateral rearfoot pressure between the three groups, which showed no significant difference ($\chi^2(2) = 4.80, p = 0.09$).
Maximal Forefoot Center of Force Trajectory Deviation

A one-way ANOVA conducted on the data yielded no significant differences in maximal forefoot deviation of the COF trajectory ($F_{2,54} = 1.19$, $p = 0.31$, $\eta^2_p = 0.04$, power = 0.25). A Chi-Square test of independence was also calculated comparing the categories of medial versus lateral rearfoot pressure between the three groups, which showed no significant difference ($\chi^2(4) = 2.77$, $p = 0.60$).

DISCUSSION

Chronic ankle instability is a complex pathology with a multitude of factors influencing its development. Based on the findings of this study, foot type and location of rearfoot and forefoot plantar pressures did not appear to contribute significantly to this pathology.

Previous studies looking at differentiating characteristics in chronic ankle instability found that subjects with ankle instability primarily had a cavovarus foot, which could affect rate or presence of lateral ankle sprains in the population. Therefore, we hypothesized that the majority of CAI subjects would be classified as pes cavus. This, however, was not the case. In fact, 63% of all subjects in this study, regardless of group, presented with pes cavus. When looking at each group individually, 42% of subjects in the control group presented with pes cavus compared to only 27% of subjects in the CAI group. The majority of the subjects in the CAI group (62%) presented with pes rectus.

In previous studies looking at plantar pressure differences in subjects with chronic ankle instability, most found that people with ankle instability had a lateral rearfoot pressure and greater lateral forefoot plantar pressure which could put them into a vulnerable position for lateral ankle sprains.$^{30-32,34-36}$ More specifically, Morrison et al$^{35}$ conducted a running study in which they found greater lateral rearfoot pressure in those with chronic ankle instability and
greater medial rearfoot pressure in copers and controls. This is contrasted with the current study in which no differences in plantar pressure were found between the groups.

Hopkins et al.\textsuperscript{32}, Huang et al.\textsuperscript{34}, and Nawata et al.\textsuperscript{30} all captured center of pressure trajectory through different data processing methods (total deviation, medial-lateral displacement, pronation-supination index, respectively), but all three found lateral deviations or lateral placements of peak plantar pressure in those with CAI. Schmidt et al.\textsuperscript{36} measured in-shoe peak plantar pressure while running and found lateral deviation in those with ankle instability as well. Nyska et al.\textsuperscript{31} found greater forces under the midfoot and lateral forefoot during the stance phase of gait in those with ankle instability. Conversely, most subjects in our study had more medial rearfoot pressure and medial deviation of center of force trajectory. One explanation for these findings is that because of previous ankle sprains, an individual with CAI could attempt to compensate in this barefoot condition by medially deviating in both rearfoot and forefoot. This deviation takes pressure off the lateral side of the foot and ankle in an effort to prevent any further ankle sprains. However, the control subjects also exhibited this medial pressure pattern. Control subjects never sprained their ankle before, and would have no need to compensate from their natural lateral rearfoot pressure.

This current study found no significant findings between the three groups despite the differences in the classification of CAI. In order to be classified as having CAI, a subject must score 11 or higher on the IdFAI questionnaire and our CAI subjects scored well above that threshold. Those subjects in the CAI group had high IdFAI scores (23 ± 5), meaning that they had more severe ankle instability. The IdFAI scores from our coper group (4 ± 2) were also not near the threshold score, meaning that these subjects did not have any instability. In regards to previous ankle sprains, the CAI group had 4 ± 2 previous ankle sprains and the coper group had
1 ± 0 ankle sprain. Again, even though this study found no significant differences between the three groups, it was not for lack of subjective ankle instability differences.

Clinical Implications

This study revealed that the majority of the subjects, regardless of their group, had pes cavus feet, medial rearfoot pressure, and medially deviated forefoot trajectory while walking. Even though this study tried to differentiate foot type and plantar pressure characteristics between the three groups as a possible explanation of their instability status differences, there were no significant differences. Therefore, based on these conclusions other variables, such as proprioceptive deficits, and differences in muscle activation and muscular recruitment, could play a larger role in the development of chronic ankle instability than foot posture characteristics.

Limitations

This study was performed dynamically by having the subjects walk barefoot on a flat surface, which is different from the typical environment of running and/or walking in shoes. Additionally, since this study was done during walking only it is hard to determine how these plantar pressures values may have been different during running. Finally, based on the prospective nature of this study we cannot determine whether the foot characteristics observed in these three groups were present before or after any ankle injuries occurred.

Future research

This study included a majority of physically active college-aged subjects from the surrounding community. Future research could be done utilizing an older population to study the impact of chronic ankle instability and foot posture and plantar pressure later in life. This could also be done on a younger population to see if these foot posture factors could have any influences early on in the development of CAI. This study could be also be repeated including a
running condition. On a different note, another aspect of future research can focus on the comparisons of clinical foot posture measurements, in which a study can compare navicular drop measurements to arch index values through the pressure mats to see if navicular drop is accurate for predicting dynamic outcomes in foot posture. We use navicular drop in many clinics and athletic training facilities, but a comparison study between navicular drop and arch index could verify if navicular drop is still an accurate measurement to utilize.

Conclusion

Foot type and location of rearfoot and forefoot plantar pressures may not contribute the development of chronic ankle instability as once believed. Other factors, such as proprioceptive deficits and neuromuscular differences, may play a greater role in the development of this complex pathology. Because of complexity of CAI, the etiology and possible interventions continue to be researched and explored. Therefore, clinicians and researchers should consider improving proprioception and strengthening interventions of the ankle joint rather than focusing on locations of plantar pressure.
References


<table>
<thead>
<tr>
<th>Group</th>
<th>Height (cm)</th>
<th>Weight (kg)</th>
<th>Age (yr)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAI</td>
<td>173.61 ± 7.84</td>
<td>73.91 ± 17.58</td>
<td>20 ± 3</td>
</tr>
<tr>
<td>Coper</td>
<td>171.34 ± 7.75</td>
<td>71.18 ± 13.00</td>
<td>20 ± 2</td>
</tr>
<tr>
<td>Control</td>
<td>169.90 ± 9.50</td>
<td>64.53 ± 14.01</td>
<td>20 ± 1</td>
</tr>
<tr>
<td>Group</td>
<td>Gender (M/F)</td>
<td>Involved Side (R/L)</td>
<td>IdFAI Mean ± SD</td>
</tr>
<tr>
<td>-------</td>
<td>--------------</td>
<td>---------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>CAI</td>
<td>9 / 11</td>
<td>15 / 5</td>
<td>23 ± 5</td>
</tr>
<tr>
<td>Coper</td>
<td>6 / 11</td>
<td>11 / 6</td>
<td>4 ± 2</td>
</tr>
<tr>
<td>Control</td>
<td>5 / 15</td>
<td>17 / 3</td>
<td>0 ± 0</td>
</tr>
<tr>
<td>Group</td>
<td>Arch Index Mean (SD)</td>
<td>Rearfoot Pressure Ratio Mean (SD)</td>
<td>Forefoot COF Trajectory Deviation Mean (SD)</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------</td>
<td>-----------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>CAI</td>
<td>0.19 (0.08)</td>
<td>1.09 (0.07)</td>
<td>-0.28 (0.82)</td>
</tr>
<tr>
<td>Coper</td>
<td>0.18 (0.09)</td>
<td>1.11 (0.09)</td>
<td>-0.14 (0.70)</td>
</tr>
<tr>
<td>Control</td>
<td>0.17 (0.08)</td>
<td>1.08 (0.10)</td>
<td>-0.53 (0.79)</td>
</tr>
</tbody>
</table>
Table 4. Distribution of Rearfoot Pressure Ratios Between Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Medial Pressure</th>
<th>Lateral Pressure</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAI</td>
<td>18</td>
<td>2</td>
</tr>
<tr>
<td>Coper</td>
<td>16</td>
<td>1</td>
</tr>
<tr>
<td>Control</td>
<td>14</td>
<td>6</td>
</tr>
</tbody>
</table>
Table 5. Distribution of Foot Type Across Subject Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Pes Cavus</th>
<th>Pes Rectus</th>
<th>Pes Planus</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAI</td>
<td>10</td>
<td>8</td>
<td>2</td>
</tr>
<tr>
<td>Coper</td>
<td>11</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>Control</td>
<td>15</td>
<td>3</td>
<td>2</td>
</tr>
</tbody>
</table>
Table 6. Distribution of Forefoot Deviations for COF Trajectory Across Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Medial</th>
<th>Neutral</th>
<th>Lateral</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAI</td>
<td>12</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>Coper</td>
<td>10</td>
<td>0</td>
<td>7</td>
</tr>
<tr>
<td>Control</td>
<td>14</td>
<td>1</td>
<td>5</td>
</tr>
</tbody>
</table>
LIST OF FIGURES

PAGE

Figure 1. Subject Walking Stance..........................................................20

Figure 2. Sample of Arch Index Measurement.................................21

Figure 3. Sample of Rearfoot Plantar Pressure Measurement............22

Figure 4. Sample of Center of Force Trajectory...............................23
Figure 1. Trial conditions a) walking
Figure 2. a) Sample of contact area measurements used for arch index calculation

\[ AI = \frac{M}{F+M+R} \]
Figure 3. a) Sample medial-to-lateral rearfoot pressure ratio at initial peak ground reaction force
b) Sample of Force vs Time graph with line at initial peak ground reaction force at which rearfoot pressure is measured
Figure 4. a) Sample of Center of Force Trajectory during walking
APPENDIX A

OPERATIONAL DEFINITIONS

ASSUMPTIONS

DELIMITATIONS

LIMITATIONS

STATEMENT OF THE PROBLEM

DEPendant AND INDEPENDENT VARIABLES

HYPOTHESIS
Operational Definitions

Acceptable Trial: Total foot contact recorded on both pressure mats with no alteration of gait during dynamic trials.

Alteration of Gait: “Stutter stepping” before approaching the pressure mats or lengthening or shortening gait cycle to step on the pressure mats.

Arch Index (AI): The ratio of the area of the middle third of a footprint relative to the total area excluding the toes.\(^1\) Equation: \( AI = \frac{M}{(H+M+F)^2} \) \([H=\text{hindfoot}, M=\text{midfoot}, F=\text{forefoot}] \) Values: pes planus = \( \geq 0.26 \), normal = 0.22-0.25, pes cavus = \( \leq 0.21 \).\(^1\)

Center of Force Trajectory: Center of force trajectory displays the movement of the center for all the forces on the pressure mat.

Chronic Ankle Instability: comprised of mechanical ankle instability and functional ankle instability\(^3\)\(^-\)\(^5\)

Copers: individuals that have recovered from a lateral ankle sprain without recurring instability.\(^6\)\(^,\)\(^7\) Subjects have no pain, weakness, or complaints of “giving way” or instability in the involved ankle, have resumed all preinjury activities without limitation for at least 12 months before testing\(^6\)\(^,\)\(^7\)

Frequent “Giving Way:” Two episodes of giving way in the last 12 months\(^6\)

Functional Ankle Instability: the condition determined by having a score of 11 or higher on the IdFAI questionnaire.\(^8\) Subjects must also have a history of ankle sprains, and episodes of “giving way.”\(^9\)

Giving Way: a temporary uncontrollable sensation of instability or rolling over of one’s ankle\(^8\)

Lateral Ankle Sprain: acute injury to the lateral aspect of the ankle after an inversion stress is applied to the ankle causing an overstretch of the lateral ligaments.
**Limb Dominance:** the foot with which a subject would kick a ball

**Lower Extremity Injury:** acute physical damage to any structures including and below the hips within the last 2-3 weeks or currently displaying symptoms of swelling, discoloration, or pain at any of these joints

**Mechanical Ankle Instability:** the anatomic changes that occur after the initial ankle sprain, which can include pathologic laxity, impaired arthrokinematics, synovial changes, and development of degenerative joint disease

**Physically Active:** participation in exercise at least 3 times a week for a duration of 30 minutes during each session

**Rearfoot medial/lateral pressure ratio:** ratio of medial peak plantar pressure divided by lateral peak plantar pressure at the moment of initial peak ground reaction force

**Uninjured subjects (control):** Control group will score a 0 on the IdFAI where they report no history of sprains and experience no episodes of giving way

**Assumptions**

The following assumptions will apply to this study:

1. Subjects will correctly remember their history of lateral ankle sprains and instability.
2. Subjects will be truthful when answering their health history and instability questionnaire.
3. The pressure mats will be able to measure an accurate distribution of plantar pressure in order to find peak plantar pressure.
4. The subjects will not alter their gait while walking over the pressure mat.
5. Subjects will be in the same maturation phase.
6. Peak Plantar Pressure is an assessment of the amount of pressure under the plantar aspect of the foot.

7. Arch Index is an assessment of the amount of pronation in the midfoot through classification of foot type.

**Delimitations**

The following delimitations apply to this study:

1. An equal number of men and women will be used in each group.

2. The participants will be physically active people who participate in exercise at least three times a week for thirty minutes per session.

3. The subjects participating will be of college-age.

4. Participants will be assigned into three groups: those with CAI, copers, and no history of lateral ankle sprain.

5. The participants will have no current lower extremity injury during data collection.

6. Participants will only attend one session for all testing.

7. Participants will be measured bilaterally while walking.

8. Three trials will be recorded while walking.

9. An averaged footprint will be made on the computer for the standing and walking trials for both feet of every subject.

10. For Arch Index (foot contact area), the averaged footprint will be divided into 3 areas: rearfoot, midfoot, and forefoot, excluding the toes.

11. For Medial/Lateral Rearfoot Pressure Ratio, the peak plantar pressures of medial and lateral rearfoot at the initial ground peak reaction force will be measured
12. For Forefoot Deviation of Center of Force Trajectory, the maximal deviation from bisection line will be measured

13. The Tekscan computer software will give the contact area, medial and lateral rearfoot pressures, and center of force trajectory for each foot.

14. Only Arch Index, Rearfoot Plantar Pressure, and Forefoot Deviation of Center of Force Trajectory will be measured.

Limitations

The following limitations will apply to this study:

1. Each subject will have varying degrees of CAI.

2. Participants may not be able to accurately classify their previous history of ankle instability.

3. Participants are measured while walking barefoot, which can be a different environment than typical ankle sprain

Statement of the Problem

Lateral ankle sprains have always been a common lower extremity injury. Factors that may play a role in having the initial ankle sprain may be generalized joint laxity, anatomic foot and ankle alignment, muscle strength of the ankle, and ligamentous stability of the ankle. Some individuals never experience an ankle sprain, while others not only sustain a lateral ankle sprain, but experience residual instability of that ankle. These people are classified as having functional ankle instability. Conversely, other people who may sustain a lateral ankle sprain go on to have no recurrent symptoms or instability. These people are classified as copers. Following a lateral ankle sprain, it is not clearly understood why some patients experience residual symptoms while others function without any impairments. Foot posture is one potential
explanation for these differences. Therefore, the purpose of my study is to characterize differences in arch index, rearfoot plantar pressure, and forefoot deviation of center of force trajectory in those with CAI, copers, and with no history of ankle sprain.

**Independent Variables**

One independent variable will be used in this study:

1. One Group at 3 levels
   a. Chronic Ankle Instability
   b. Copers
   c. No history of ankle injury

**Dependent Variables**

Two dependent variables will be evaluated in this study:

1. Arch Index: One variable (ratio) of 3
2. Rearfoot medial/lateral pressure ratio at initial peak ground reaction force
3. Maximal deviation from COF trajectory during stance phase (cm)

**Research Hypotheses**

1. There will be a lower arch index in those with CAI than controls.
2. There will be a lower arch index in those with CAI than copers.
3. There will be a greater lateral rearfoot pressure ratio in those with CAI than controls.
4. There will be a greater lateral rearfoot pressure ratio in those with CAI than copers.
5. There will be a greater forefoot deviation from COF trajectory in those with CAI than controls.
6. There will be a greater forefoot deviation from COF trajectory in those with CAI than copers.
Statistical Hypothesis

1. Arch Index
   \[ H_A: \mu_C \neq \mu_{CAI} \neq \mu_{Copers} \]

2. Rearfoot medial/lateral pressure ratio at initial peak ground reaction force
   \[ H_A: \mu_C \neq \mu_{CAI} \neq \mu_{Copers} \]

3. Maximal deviation of COF trajectory during stance phase
   \[ H_A: \mu_C \neq \mu_{CAI} \neq \mu_{Copers} \]

Null Hypothesis

1. Arch Index
   \[ H_A: \mu_C = \mu_{CAI} = \mu_{Copers} \]

2. Rearfoot medial/lateral pressure ratio at initial peak ground reaction force
   \[ H_A: \mu_C = \mu_{CAI} = \mu_{Copers} \]

3. Maximal deviation of COF trajectory during stance phase
   \[ H_A: \mu_C \neq \mu_{CAI} \neq \mu_{Copers} \]
References

APPENDIX B

REVIEW OF LITERATURE
REVIEW OF LITERATURE

This literature review will address the topics that are involved with the investigation of differences in peak plantar pressure and arch index in those with functional ankle instability, copers, and with no history of lateral ankle sprain. This review will cover: (1) ankle instability, (2) measuring FAI, (3) foot and ankle biomechanics, (4) predisposing factors for ankle injury, (5) measuring foot posture, and (6) the relationship between foot posture (plantar pressure and arch index) in those with FAI.

Ankle Instability

Lateral ankle sprains are one of the most common injuries that occur in sports. While there are some athletes who sustain an ankle sprain and never experience one again, others have recurrent ankle sprains leading to more problematic situations. Additionally, there are those individuals, called “copers” who have suffered a lateral ankle sprain, but do not develop signs and symptoms of ankle instability. These individuals are able to return to high-level activities as if uninjured and continue without any recurrent injury.\(^1\)\(^-\)\(^5\) In a study incorporating 380 athletes, 73% suffered from recurrent sprains and 59% of those athletes experienced significant disability and residual symptoms including instability.\(^6\) Chronic ankle instability (CAI) is a complex pathology that arises when repetitive ankle sprains occur and there are residual symptoms after the ankle sprain heals.\(^7\)\(^,\)\(^8\) CAI is described as being comprised of two groups: mechanical ankle instability and functional ankle instability.\(^7\)\(^-\)\(^9\) Mechanical ankle instability (MAI) is defined as the anatomic changes that occur after the initial ankle sprain, which can include pathologic laxity, impaired arthokinematics, synovial changes, and development of degenerative joint disease.\(^10\) These changes occur at the physiological level and are more objective in nature. Laxity that occurs in MAI results from damage to the ligamentous structures of the ankle joint.
and can be assessed through physical examination by talar tilt tests and anterior drawer tests, stress radiography, or instrumented arthrometry, which all try to assess the degree of laxity within the joint.\textsuperscript{10} While MAI is the objective side to ankle instability, FAI is the subjective feeling of ankle instability, having a history of ankle sprains, and experiencing episodes of your ankle giving way. Functional ankle instability (FAI) is defined as the perceived awareness of the ankle to “give way” or to be weak and unstable.\textsuperscript{11} Contributing factors which lead to FAI can include deficits in ankle proprioception, cutaneous sensation, nerve-conduction velocity, neuromuscular response times, postural control, and strength.\textsuperscript{10} Freeman\textsuperscript{12} was the first to describe FAI in people who he found to have proprioceptive deficits as their main cause of this “giving way” feeling.

\textit{Ankle Instability Questionnaires}

Self-reported questionnaires are the primary mechanism to determine the presence of FAI. There are many questionnaires available to determine the presence of ankle instability and a few that are FAI specific questionnaires. Questionnaires can be broken down into two different groups. Discriminative instruments help to identify subjects with a particular disorder while evaluative instruments are to measure a subject’s change in status over time during a treatment and then to assess the effectiveness of said treatment.\textsuperscript{13} The questionnaires that have been used in the past to identify those with ankle instability include: the Ankle Instability Instrument (AII), Ankle Joint Functional Assessment Tool (AJFAT), Chronic Ankle Instability Scale (CAIS), Cumberland Ankle Instability Tool (CAII), Foot and Ankle Ability Measure (FAAM), Foot and Ankle Instability Questionnaire (FAIQ), Foot and Ankle Outcome Score (FAOS), and the Identification of Functional Ankle Instability (IdFAI).
The AII was specifically designed to determine the presence of functional ankle instability. It is comprised of nine item questions with three sub questions if an answer is ‘yes.’ These questions are a part of three separate groups: Factor 1 (severity of the initial ankle sprain), Factor 2 (history of ankle instability), and Factor 3 (instability during activities of daily life). Participants were considered to have FAI if they answered ‘yes’ to five or more out of the nine yes/no questions. The AII was proven to have good test-retest reliability (ICC = 0.70 to 0.89).

The AJFAT is comprised of twelve questions that rates (1) ankle pain, (2) ankle swelling, (3) ability to walk on uneven surfaces, (4) overall feeling of stability, (5) overall ankle strength, (6) ability to descend stairs, (7) ability to jog, (8) ability to change direction when running, (9) overall activity level, (10) ability to sense a “rollover” event, (11) ability to respond to a “rollover” event, and (12) ability to return to activity after a “rollover” event. Participants based their answers comparing their involved ankle to their non-involved ankle, and had point values of 0-4. Scores of 26 or higher out of 48 were deemed to have FAI. The AJFAT is shown to have a high test-retest reliability (ICC = 0.94).

The CAIS consists of fourteen items referring to impairment, disability, participation problems, and emotion, and scored on a five point Likert scale ranging from 4 (best) to 0 points (worst). The lower the score corresponds to a lower degree of ankle function, and a higher score means a higher degree of ankle stability. The average score of participants with CAI is 29. The CAIS is used for specifically detecting chronic ankle instability and has a test-re-test reliability of ICC = 0.84.

The CAIT is a questionnaire specifically used for assessing functional ankle instability and is composed of nine items with a range of answers asking about various moments when their
ankle may feel unstable. Each answer is assigned a point value from 0 to 5 and each ankle of each subject is scored separately. The CAIT was found to have excellent test-retest reliability (ICC = 0.96).\textsuperscript{14,18} A lower score reflects a greater instability and participants with a score of 23 or less are likely to have FAI.\textsuperscript{19}

The FAAM originated from the Foot and Ankle Disability Index (FADI). They both include two groups: “activities of daily living” and “sports” subscales. The main difference between the FAAM and the FADI is because of the removal of the “sleeping” item and four “pain-related” items from the “activities of daily living scale” to create the FAAM. The score for the “activities of daily living” subscale can range from 0 to 84 points and the “sport” subscale score can range from 0 to 32 points. Each subgroup score is converted to percentiles and a score below 90\% on each means that participant has FAI. The reliability for each subscale was good with ICC = 0.89 for “activities of daily living” and ICC = 0.87 for the “sport” scale.\textsuperscript{14,20}

The FAIQ is a ten item questionnaire including information related to sensation of weakness, episodes of giving way during daily activity, injury within the past three months, and no formal rehabilitation of the involved ankle. To determine the presence of FAI, participants must answer ‘yes’ to questions 3, 5, 6, 7, and 9, while answering ‘no’ to questions 4, 8, and 10.\textsuperscript{14,21} The FAIQ has not had any reliability information reported on it.\textsuperscript{14,18}

The FAOS is a larger questionnaire comprised of 42 items that are divided into 5 groups: pain (9 questions), other symptoms (7 questions), activities of daily living (17 questions), sport and recreation function (5 questions), and foot and ankle-related quality of life (4 questions). Each question is scored on a 5-point Likert scale (0-4) and each of the 5 group scores are added up. Raw scores are then changed into a 0 to 100, worst to best score. Scoring below 75\% in three or more groups is indicative of participants with FAI.\textsuperscript{14,22}
Donahue et al\textsuperscript{14} performed a study investigating which already established questionnaires would provide the best background information from people regarding their history with ankle instability. They took into account seven different questionnaires: Ankle Instability Instrument (AII), Ankle Joint Functional Assessment Tool (AJFAT), Chronic Ankle Instability Scale (CAIS), Cumberland Ankle Instability Tool (CAIT), Foot and Ankle Ability Measure (FAAM), Foot and Ankle Instability Questionnaire (FAIQ), and Foot and Ankle Outcome Score (FAOS). They found two questionnaires, when used together, provided the best prediction of ankle instability, which were the CAIT and AII. Donahue et al\textsuperscript{14} suggested at the time that future researchers should use these two questionnaires in their studies.

In another study, Simon et al\textsuperscript{23} developed a new questionnaire named the Identification of Functional Ankle Instability (IdFAI). The IdFAI has shown to have an 89.6\% accuracy for detecting functional ankle instability.\textsuperscript{23} The researchers made sure to include a definition of the classic term “giving way” that helped make subjects’ responses reliable. The questionnaire was long enough to assess FAI, but short enough to prevent dissatisfaction. In comparison with the other questionnaires, the study showed that the IdFAI was more efficient at determining subjects who do have functional ankle instability, while the combined use of the AII and CAIT was more efficient at determining subjects who do not have functional ankle instability.\textsuperscript{23}

\textbf{Foot and ankle biomechanics}

The foot and ankle consists of three articulations which include the talocrural joint, the subtalar joint, and the distal tibiofibular syndesmosis.\textsuperscript{10} These articulations work together to produce the rearfoot motion of the ankle. Rearfoot motion occurs in all three cardinal planes: sagittal, frontal, and transverse. Plantarflexion and dorsiflexion occur in the sagittal plane. Inversion and eversion occur in the frontal plane. Internal rotation and external rotation occur in
the transverse plane. These movements occur simultaneously in a coordinated fashion in an oblique axis of rotation in the ankle.\textsuperscript{10}

The talocrural joint is formed by the articulation of the dome of the talus, the medial malleolus, the tibial plafond, and the lateral malleolus.\textsuperscript{10} This joint may be viewed as a synovial hinge joint and has one degree of freedom of movement: dorsiflexion and plantarflexion.\textsuperscript{24} The axis of rotation is oblique, passing through the medial and lateral malleoli.\textsuperscript{10} The subtalar joint is formed from three articulations of the talus and the calcaneus. The posterior articulation is a concave facet on the talus while the anterior and middle articulations are convex talar facets. Clinically, the motion described in the subtalar joint is ‘inversion’ and ‘eversion,’ but the movement is pronation and supination which occurs in an oblique axis that goes through all three cardinal planes.\textsuperscript{24} These two joints work to transform the torque from the lower leg (internal and external rotation) to the foot (pronation and supination).\textsuperscript{10}

**Predisposing factors for ankle injury**

Since ankle sprains occur at a high rate both in the general and athletic populations, it is important to look at the factors that may predispose individuals to have that initial ankle sprain. Many researchers have looked at both extrinsic and intrinsic risk factors that may predispose someone to an ankle injury. Examples of extrinsic, or external, risk factors are level of play, exercise load, amount of training, position played, equipment, playing field conditions, rules, foul play, and others that are environmentally-related.\textsuperscript{25,26} These extrinsic factors might be more difficult for clinicians to prevent. Intrinsic, or internal, risk factors which include patient demographics,\textsuperscript{6,11,27,28} ligamentous stability,\textsuperscript{27,29,30} postural sway,\textsuperscript{30,31} muscular strength,\textsuperscript{27} gait mechanics,\textsuperscript{32} muscle reaction time,\textsuperscript{27,31} and anatomic foot and ankle alignment\textsuperscript{27,28,33,34} might be
items that once identified, a healthcare practitioner can manipulate to prevent future injuries from occurring.

**Measuring Foot Posture**

The foot is one of the most intricate units of the body. This intricacy has led to multiple methods of measuring different aspects of the forefoot, midfoot, and rearfoot. Most methods can be divided into three different categories including radiographic measurement, anthropometric measurements, and visual inspection. Radiographic measurements are typically used for comparison of reliability with other static measurements. Even though radiographs are highly reliable by actually showing the bony anatomy of the foot and ankle, this method inherently requires more technology and a more difficult process if there is a high number of subjects to be tested. Anthropic measurement, which refers to the actual measurement of the size and proportions of the human body, typically include measurement of the subtalar joint neutral, forefoot to rearfoot alignment, navicular drop, navicular drift, arch height, medial longitudinal arch (MLA), and valgus index. Visual inspection incorporates the Foot Posture Index (FPI).

Three main classifications exist for foot type. The first classification is the normal or rectus foot. The second classification is the pes planus foot type, which is considered to be overpronated. Pes planus can also incorporate rearfoot valgus and excessive forefoot varus. The third classification is pes cavus, which is considered as an oversupinated foot. Pes cavus can also incorporate a high arch and excessive rearfoot varus.

Most methods of foot posture begin with finding the subtalar joint neutral position as a starting point. Subtalar joint neutral (STJN) is defined as the position in which the medial and lateral aspects of the talar head are equally palpable on both side of the ankle joint. STJN can be considered as the basis for the “ideal foot” in which the foot is in near perfect alignment for
that individual.\textsuperscript{41} STJN can be measured in three ways through standing in a closed kinetic chain (CKC), seated, or lying prone in an open kinetic chain (OKC).\textsuperscript{42,43} The standing CKC position is considered to be the ideal position for measuring STJN because in this weight-bearing position, the subtalar joint moves similarly to how it functionally operates.\textsuperscript{44} For the OKC position, the STJN position is identified by palpation of the medial and lateral aspects of the talus\textsuperscript{45} and pronating and supinating the forefoot until the talus is equally palpable at the medial and lateral borders and then dorsiflexed until there is a soft end feel.\textsuperscript{42}

A normal range for STJN has not been established in the literature but stated that for normal foot types, STJN is typically greater than two degrees of varus and less than two degrees of valgus.\textsuperscript{46} For seated and standing CKC position, the same method of palpation is applied but the supination and pronation of the foot is performed by the subject until the examiner finds STJN. Low reliability has been found in both the OKC and CKC positions, with intraclass correlation coefficients (ICC) ranging from 0.00 – 0.76 for interrater reliability\textsuperscript{41,47-49} and 0.06 – 0.91 for intrarater reliability\textsuperscript{41,47} both in the OKC position. CKC position had 0.14 – 0.18 for intrarater reliability\textsuperscript{47} and 0.15 for interrater reliability.\textsuperscript{47} One study revealed that an examiner’s ability to find STJN is more reliable in a seated position and that an examiner’s preference of subject positioning does not necessarily effect the ability to find STJN correctly.\textsuperscript{42} The information above shows a high degree of variability in the reliability of finding and measuring STJN, which makes it difficult to determine a valid method. Another problem is the limitation of the examiner’s experience.\textsuperscript{47} Similar studies showed that examiners with experience were 90\% more likely to place the foot within three degrees of STJN.\textsuperscript{43} However, other studies used testers with at least one year experience and found unreliable results.\textsuperscript{48,50}
In order to bridge the gap between taking static measurements for movements that occur dynamically, there are a few studies that utilize a gait template on which their subjects stand for the duration of the static measurements.\textsuperscript{37,51-54} This gait template then represents the natural toe-out or toe-in gait stance of that individual. There are two different ways in which to construct this gait template. McPoil et al,\textsuperscript{54} Sell et al,\textsuperscript{51} and Holmes et al\textsuperscript{52} had subjects dip their feet into either mineral oil or water-soluble paint and then walk across a 6-meter strip of butcher paper. Each subject walked at a normal pace and the middle four footprints were used. A straight line was drawn between the medial heel edges of the two right footprints and then the two left footprints. The distance between the two lines was the base of the gait, which was bisected by drawing a line down the measured center. Two footprints were aligned beside each other after cutting along the bisection line. The end result was a bilateral foot template which represented the normal gait stance of that individual.\textsuperscript{51,52} The other method used by Buchanan and Davis\textsuperscript{37} and Gupta et al\textsuperscript{53} incorporated subjects walking along a 4-meter length and come to a stop on a square piece of paper in which they were in a bilateral stance with both legs in a foot placement angle that was most comfortable. Four practice trials occurred before the feet were traced on the fifth trial with a pen.\textsuperscript{37} Again, this allowed for a standard stance for each subject that represented his or her natural gait.

\textit{Forefoot to rearfoot alignment (FRA)}

The forefoot to rearfoot alignment (FRA) position is another anthropometric measurement that is measured in an open kinetic chain (OKC) position. The FRA measures the relationship between the forefoot and the rearfoot in relation to the plantar plane.\textsuperscript{55} During the measurement of the FRA, the STJN position should be found and held in that position. Two methods exist using a goniometer to measure the FRA. One method is finding the angle between
the bisection of the calcaneus and an imaginary line drawn through the metatarsal heads. The reliability of this method is significant with an ICC of 0.97. The second method of measuring FRA involved markings placed over the first and fifth metatarsal heads and then the stationary arm of the goniometer is aligned parallel to the floor or table while the moveable arm is aligned with the markings on the metatarsal heads. Intrarater reliability was good and showed ICCs of 0.85 – 0.92 for this method, while intertester reliability was poor with an ICC of 0.56. These results agree with other studies that showed a poor interrater reliability (ICC 0.61 – 0.70) and excellent intrarater reliability (ICC 0.82 – 0.99).

Forefoot varus is determined when the forefoot is inverted relative to the rearfoot while forefoot valgus is defined when the forefoot is everted relative to the rearfoot. There is no accepted universal range, but the FRA measurement greater than four degrees varus is a planus foot type, and a measurement greater than four degrees valgus is a cavus foot type.

**Midfoot measurements**

The most consistently used methods to measure the midfoot are navicular drop, navicular drift, and medial longitudinal arch angle (MLA). Navicular drop has been a common method used in the clinical setting and is a common measurement of foot posture. To begin this measurement STJN is found as the subject is in 50% weight-bearing and the navicular tuberosity is marked. While maintaining the STJN position, the height from the marked navicular tuberosity to the floor is noted. The subject is then to transition into full weight-bearing and then the height is measured a second time. The difference between the two measurements is found and represents the navicular drop. A normal navicular drop is considered to be about ten millimeters and an abnormal navicular drop is fifteen millimeters or more. Ways in which to measure navicular drop can vary between researchers. Some
researchers either utilize note cards to mark the height measurements, a plastic ruler imbedded in a foam block, an electromechanical, three-dimensional digitizer called the Metrecom, or the Vernier height gauge (Mitutoyo, Japan). Reliability for navicular drop varies. Intratester data for reliability for the index card method ranges of the in ICC 0.44 – 0.91 and intertester reliability ranges in ICC 0.56 – 0.78. However Sell et al found an intratester reliability for the index card method an ICC of 0.95 and intertester reliability ICC of 0.96. For the Vernier height gauge, Gilmour and Burn report an interrater reliability as ICC of 0.77-0.80 and an intrarater reliability as 0.91 for measuring navicular drop. Between these methods of measuring navicular drop, the index card is the cheapest but has the most inherent error while the Vernier height gauge can still be somewhat inexpensive but more accurate.

Navicular drift is another midfoot posture measurement, and refers to the degree in which the navicular is medially displaced. Navicular drift is measured similarly to navicular drop. The subject is positioned into STJN in standing and the navicular tuberosity is noted on paper on which the subject is standing. The subject is instructed to relax to full weight-bearing and the position of the navicular tuberosity is noted a second time. Little reliability has been determined even though navicular drift continues to be commonly used. Reliability ranged from 0.44 – 0.77 for intratester reliability and 0.32 – 0.53 for intertester reliability. Even though there is variability in reliable navicular drift measurements, researchers admit that navicular drift measures differences of the medial longitudinal arch in both the frontal and sagittal planes.

Another commonly used arch measurement is the medial longitudinal arch (MLA) height and angle. Measurement of the arch height can be measured from the navicular bone to the floor or from the soft tissue margin of arch to the floor, which causes some discrepancy with this measurement. The measurement is taken in centimeters or millimeters with a ruler.
Measurements using a ruler for navicular height have shown a moderate reliability with intrarater ICCs at 0.84 and interrater ICCs at 0.76. Normal values are not well established but one study stated that arch height, measured using the soft tissue margin as the reference point, ranged from 20-30 millimeters in a normal population. Another study stated that individuals with high arches measure at 34 mm or above, and individuals with low arches measure 30 mm or below. Using a caliper is another instrument useful in measuring arch height. This caliper method measures arch height from the floor or supporting surface to one of three reference points on the foot, which include the medial projection of the navicular, the medial projection of the talus, and the highest point of the medial longitudinal arch. Hawes et al reported high intertester (ICC 0.98) and intratester (ICC 0.99) reliability while using the caliper method for measuring arch height.

Valgus Index

Another anthropometric measurement used to quantify foot posture is the valgus index which is an indicator of foot position in relation to the malleoli. This measure was originally performed using an ink footprint to determine the relationship between the heel and the malleoli. However this original method had low intra- and inter-reliability so the malleolar valgus index is modified version of the valgus index. This modified version uses a computerized image of the foot and transmalleolar axis which results in an image of a footprint. From this footprint, the center of the ankle and foot are calculated. For the purpose of differentiating between foot types, this method reported 100% and 90.9% correct classifications of pes planus and pes rectus feet, respectively.

Foot Posture Index (FPI)
One current method of visual assessment is the Foot Posture Index (FPI) which observes and rates foot posture in multiple planes while the subject is in a static weight-bearing position. The current index (FPI-6) involves six criteria which include talar head palpation, curves above and below the lateral malleoli, inversion/eversion of the calcaneus, prominence of a bulge in the region of the talonavicular joint, congruence of the medial longitudinal arch, and abduction/adduction of the forefoot on the rearfoot. Scores for the FPI-6 can range from -12 to +12. A negative score from -12 to -10 represents an abnormally supinated foot while a positive score ranging from +3 to +12 represents an abnormally pronated foot. Scores between -2 to +2 are considered normal. The FPI-6 was tested and showed intratester reliability ranges from 0.81-0.91. While this is a relatively new method, a few clinicians and researchers have utilized the FPI to determine and classify foot type and have found it to be useful.

**Foot Angle**

Many studies have taken a different type of foot measurement called the foot angle. Foot angle is the degree of in-toeing or out-toeing of the foot relative to the forward line of progression and is measured through the use of footprints. On the footprint, lines are drawn along the medial border of the footprint, then perpendicular lines at the end of the toes and back of the heel. Another line is drawn along the lateral border of the footprint. The foot is divided equally into three parts with lines drawn perpendicular to the medial border. The final line bisects the medial and lateral borders, resulting in a line in that is the degree angle of the forward line of progression. Murray et al was one of the first researchers to measure foot angle, in which he used healthy males of various ages and found that the older males had more out-toeing than younger subjects. Nawata et al studied foot angle in those with and without functional ankle instability (FAI) and used pressure mats to capture the footprint data. This study found
that those with FAI had a significantly lower mean foot angle than those in the control group, which mean that those with FAI had more in-toeing and those in the control group had more out-toeing.\textsuperscript{70}

\textit{Plantar Pressure}

Some studies are done with the purpose of relating a certain foot type classification with a particular pattern of plantar pressure. Burns et al\textsuperscript{75} looked at the effect of pes cavus on plantar pressure and found that individuals with pes cavus feet have a higher pressure-time integral than those with normal feet. Pressure-time integral is the sum of peak pressure in each frame of foot contact multiplied by the duration of foot contact.\textsuperscript{75} The pes cavus group, therefore, exhibited an increase in peak pressure beneath the rearfoot and forefoot while walking.\textsuperscript{75} Chuckpaiwong et al\textsuperscript{76} examined flat feet (pes planus) compared to normal feet (pes rectus) in their plantar pressures while walking and running. This study found that the contact area and maximum force in the medial midfoot were significantly greater for the low arch group while the peak pressure and maximum force in the lateral forefoot were significantly decreased in the low arch group as compared to the normal group.\textsuperscript{76} These studies showed that a higher peak pressure in the lateral side of the foot occurs in those with pes cavus classification and a lower lateral peak pressure occurs in those with a pes planus classification.

A few studies have looked at the relationship between dynamic foot pressure and ankle instability.\textsuperscript{70,77-82} Nawata et al,\textsuperscript{70} Nyska et al,\textsuperscript{77} and Hopkins et al,\textsuperscript{78} used walking as the dynamic action in their studies with functional ankle instability\textsuperscript{70,78} and chronic ankle instability.\textsuperscript{77} Nawata et al\textsuperscript{70} used the variable of the pronation-supination index to indirectly measure the amount of pronation or supination in the stance phase of gait to quantify the location of the center of pressure (COP). Nyska et al\textsuperscript{77} used the variables of relative peak force and relative
timing under six regions of the foot with pressure mats. Hopkins et al\textsuperscript{78} used foot COP trajectory during walking to find differences in their subjects. Despite the methodological differences in their choice of variables, each of these three studies found a more laterally deviated foot pattern in those with ankle instability than those in the control groups.\textsuperscript{70,77,78} By finding a greater supination,\textsuperscript{70} more relative force under the lateral forefoot,\textsuperscript{77} or a laterally deviated COP,\textsuperscript{78} these studies showed a significant difference between groups. It is stated that because of this greater supination in the stance phase\textsuperscript{70} and a more laterally deviated COP,\textsuperscript{78} the ankles of those with functional instability are placed in a more compromised position for recurrent sprains.\textsuperscript{70,78}

One study by Becker et al\textsuperscript{79} investigated the difference between functional ankle instability and mechanical ankle instability with dynamic plantar pressure and found that those with FAI had increased lateral loading but those with MAI had more pressure on the medial side of their unstable ankle.\textsuperscript{79} Three additional studies looked at plantar pressure in ankle instability subjects with running as their dynamic movement.\textsuperscript{80-82} Huang et al\textsuperscript{80} measured peak pressure and displacement of COP during the stance phase while lateral shuffling and running. Morrison et al\textsuperscript{81} measured rearfoot medial/lateral pressure ratio at foot strike and COP trajectory during the initial loading response. Schmidt et al\textsuperscript{82} measured multiple variables including maximum force and peak pressure with in-shoe pressure sensors while subjects jogged. These three studies showed a lateral COP during the loading phase\textsuperscript{80,81} greater maximum force and peak pressure\textsuperscript{82} in the lateral midfoot and forefoot in the ankle instability group when compared to controls. As related to the previous walking studies, the running studies related ankle instability to a more laterally deviated COP and greater plantar pressure to the lateral part of the foot.\textsuperscript{80-82}

Arch Index
There has yet to be a “gold standard” for foot type classification, but many studies have utilized an indirect method of measuring the medial longitudinal arch by using the arch index.63,83-88 The arch index was first developed and used by Cavanagh and Rogers83 and it represents the ratio of the area of the middle third of a footprint relative to the total area excluding the toes. After a footprint is taken, the length of the footprint excluding the toes is divided into equal thirds and the arch index is calculated as the area of the middle third divided by the entire footprint area.87 A representation of the equation is AI = M/(H+M+F) where H=hindfoot, M=midfoot, and F=forefoot.84 According to Cavanagh and Rogers83 a low arch index (flatter foot) is ≥0.26, a normal arch index is 0.22-0.25, and a high arch index (high arch) is ≤0.21.83,87 Footprint data can be collected through a mirrored photo-box,88 carbon paper,86,87 and pressure mat systems.84,85 Using a mirrored photo-box with asymptomatic subjects standing, showed a range of 0.017 to 0.370 and an interrater reliability of ICC = 0.90.88 Studies using carbon imprint paper86,87 found the arch index using the footprint areas found through computer graphic software through a computer graphics tablet. These particular studies86,87 used older asymptomatic subjects, but found a significant association between arch index and radiographs with a P<0.01.86 Researchers also found a reliability of ICC=0.99 with the use of carbon paper.86 Other studies used the EMED-SF capacitance mat transducer system (pressure mat) through computer software to measure arch index on asymptomatic individuals.84,85

Conclusion

Functional ankle instability is a dynamic pathology that can affect an individual in many different ways, including strength and balance deficits. While most researchers can agree on the subjective feeling of “giving way” to help classify FAI, a universal understanding of factors that completely define FAI is still lacking. Measuring peak plantar pressure and arch index in those
with FAI, copers, and those with no history of lateral ankle sprains may help to further classify a particular foot posture associated with FAI and find a difference between those with FAI and copers.
References


APPENDIX C

DATA PROCEDURES CHECKLIST
Data Procedures Checklist

Before subject arrives:
1. Unpack HR pressure mats
2. Set up HR mat
   a. Arrange pressure mats one front of the other
   b. Attach 2 sensors to the pressure mat
   c. Plug in 2 sensors into the control box
   d. Plug in USB cable to computer: Mat 1 into right USB slot, Mat 2 into left USB slot
   e. Plug control box into wall power outlet
3. Open pressure mat software
   a. Select “file” and open “patients” window
   b. Create new subject file or open existing subject file

Upon subject arrival:
1. Make sure subject understands IRB informed consent form
2. Have subject fill out medical history questionnaire
3. Record demographic information (age, height, and weight)
4. Have subject fill out IdFAI questionnaire
5. Explain testing procedure to subject through demonstration

Plantar pressure measurement procedure:
1. Open HR mat Research Software V. 6.60
2. For new recording, exit patients window and select “new recording” from the menu bar.
3. Calibrate the mat for the new subject for static standing
   a. Select “Tools” and “Calibration”
   b. Select “Step” in the calibration window for Mat 1
   c. Enter subject’s weight and click start. Instruct subject to step on the mat with both feet when the footprint in the window turns green
   d. Save calibration to subject folder by clicking “Save Cal. File”
4. Instruct subject to stand with both feet on the pressure mat in a comfortable stance.
5. Instruct subject to stay standing for 10 seconds while “new recording” starts
6. Select “Save Movie As” to save movie under Subject File
7. Repeat steps 4 and 5 twice, for a total of 3 trials
8. Calibrate the mats again for the walking trials
   a. Select “Tools” and “Calibration”
   b. Select “Walk” in the calibration window
   c. Enter subject’s weight and click OK. Mats are automatically calibrated based on weight.
9. Begin practice trials
a. Instruct subject to start at Mat 2, walk forward for 6 steps, and turn around  
b. Mark spot on floor with tape  
c. Instruct subject to start walking from marked spot toward the mats, looking  
   straight ahead at the wall  
d. Check to see if each foot hits near center of the mats  
e. Adjust distance between mats accordingly  
f. Continue with practice trials (~4-8 trials) adjusting walking distance from mats as  
   needed, until subject feels comfortable with their gait  

10. Begin test trials  
a. Instruct subject to line up at their marked spot  
b. Hit record button and tell subject to start walking towards the mats looking  
   straight ahead  
c. Computer software will stop recording after 400 frames are captured (approx. 10  
   sec)  
d. Once a trial is complete – Select “View” → “Movie Contac Averaging” for each  
   pressure mat frame to view if footprint data was captured  
e. Select “File” → “Save Movie As” (*do not save to the database when prompted)  
   i. Save each trial – example – “1R_T1” and “1L_T1” where “1R” or “1L”  
      correlates to Subject # and Foot Side and “T1” correlates to Trial #  
   ii. Each subject will have their own folder where all data collected will be  
       saved  
f. Repeat steps a-e for each trial for each subject  
g. Complete 3 acceptable trials per subject  

**Data Processing Procedures**  

**Box Placement on Average Footprint**  
1. Object lines and boxes can be saved as a template for repeated use across all footprints in  
the software.  
2. Click “add line” and click inside the selected data window  
3. Drag line to the lateral side of the foot to match and capture the length of the foot. The  
   line automatically measures the length of the foot in cm.  
4. Click “add line” again and click inside the selected data window  
5. Drag line to line up with end of heel, perpendicular to the first line  
6. Click “add line” again and click inside the selected data window  
7. Drag line to the medial side of the foot and make its distance 1/3 of length of total  
   distance of foot as shown by the first full length line  
8. Repeat steps 8 & 9 two more times to divide the rest of the foot  
9. Click “add box” and click inside the selected data window  
10. Select “new graph”
11. Drag and resize the box to rearfoot to match 1/3 length of the foot
12. Repeat steps 11-13 for the midfoot
13. Click “add polygon” and click inside the selected data window
14. Select “new graph”
15. Draw polygon to capture the forefoot, excluding the toes
16. Click “analysis” and select “save object file”
17. Save template
18. For all other movies for selected subject, select next data window, click “analysis” and click “load object file”
19. The mask template will open on the next trial data window. The boxes and lines can be relocated and resized as needed to be as consistent as possible for positioning

Arch Index – Contact Area
1. Select “File” → “Open movie”
2. Open the subject’s folder and select the movie to be analyzed
3. Click “View” → “Movie averaging” for standing measurements or “Movie contact averaging” for walking measurements, to average the 400 frames into one shot
4. Click “Analysis” and click “Load object file” for box/line template for analysis
5. Adjust lines first, followed by boxes for that individual footprint
6. Click “analysis” → “properties” and select “contact area”
7. Enter in the contact area information from the three boxes for both standing and walking trials of each subject into Excel for data processing
8. Arch index will be calculated for each footprint using the equation described in the methods section

Medial/Lateral Rearfoot Pressure Ratio
1. Select “File” -> “Open movie”
2. Open the subject’s folder and select the movie to be analyzed
3. Click “Peak Stance” to view composite footprint
4. Click “Add box” to create box that encompasses the entire footprint
5. Through that newly created box, a Time vs Force graph is created in a separate tab
6. Click “Add line” to draw a bisection line from mid-line of calcaneus to space between 2nd and 3rd metatarsals, which divides the foot into medial & lateral sections
7. Click “Add polygon” to draw box around medial rearfoot
8. Click “Add polygon” to draw box around lateral rearfoot
9. Deselect “peak stance” in order to play through individual frames
10. Click on Time vs Force graph and with the right arrow button, click through each frame count to the initial peak ground reaction force
11. Record in Excel the medial and lateral peak plantar pressure of the rearfoot from the software picture
12. In Excel, the medial pressure is divided by that lateral pressure to create a ratio

**Forefoot Deviation of Center of Force Trajectory**

1. Select “File” -> “Open movie”
2. Open the subject’s folder and select the movie to be analyzed
3. Click “Peak Stance” to view composite footprint
4. Click “Add line” to draw a bisection line from mid-line of calcaneus to space between 2nd and 3rd metatarsals, which divides the foot into medial & lateral sections
5. Click “COF trajectory” to show the trajectory line
6. Click “Print preview” to preview the page of the footprint to be printed
7. Print the composite footprint (which includes bisection line and COF trajectory line)
8. Measure in the forefoot in centimeters the greatest deviation space between the bisection line and COF trajectory
9. Record values (lateral = positive; medial = negative) in Excel
APPENDIX D

DATA COLLECTION FORM

HEALTH HISTORY QUESTIONNAIRE

IDENTIFICATION OF FUNCTIONAL ANKLE INSTABILITY
DATA COLLECTION FORM

Differences in Peak Plantar Pressure and Arch Index in Those with Functional Ankle Instability, Copers, and No History of Lateral Ankle Sprain

Study #: 1307011852

Subject #: _______

Informed Consent Form: _____

Group: FAI Coper Control

Medical History Questionnaire: _____

Inj. Side: R L B

IdFAI Questionnaire: _____

Limb Dominance: R L

Inclusion Criteria: (Y/N) _____ Physical Activity (minimum 3x 30min/week)

Exclusion Criteria: (Y/N) _____ Acute Injury (within 3 months)

_____ Surgery in lower extremity

_____ Fracture in lower extremity

Height: _______ Weight: _______ Age: _______

Pressure Mat Measurements Completion: Checkmark = Recorded and Saved

Add File Name: i.e. Subject#_condition_limb_trial#

Standing - Bipedal
Calibration _____
Trial _____

Standing - Unipedal
Calibration _____ Calibration _____
Left Foot Trial _____ Right Foot Trial _____

Walking
Calibration _____
Left Foot Trial 1 _____ Right Foot Trial 1 _____
Left Foot Trial 2 _____ Right Foot Trial 2 _____
Left Foot Trial 3 _____ Right Foot Trial 3 _____
Medical History Questionnaire

<table>
<thead>
<tr>
<th>Question</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Do you currently have any orthopedic problems?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If yes, please explain</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Have you suffered any injury to the lower extremity of either leg</td>
<td></td>
<td></td>
</tr>
<tr>
<td>within the past 3 months?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If yes, please explain</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Have you had any fractures to the lower extremity?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If yes, please explain</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. Have you had any surgeries to the lower extremity?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If yes, please explain</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Are you currently suffering from any illnesses? (i.e. common cold,</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ear infection, sinus infection, etc)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If yes, please explain</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. Have you suffered a head injury within the past month?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If yes, please explain</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7. Do you have any neurological disorders or experience trouble</td>
<td></td>
<td></td>
</tr>
<tr>
<td>balancing?</td>
<td></td>
<td></td>
</tr>
<tr>
<td>If yes, please explain</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8. Do you currently engage in physical activity for at least 30 minutes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 times a week excluding competitive athletics?</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*** All information will be kept strictly confidential and will have no connection with your identity at the conclusion of the study.***
IdFAI Questionnaire:

IDENTIFICATION OF FUNCTIONAL ANKLE INSTABILITY (IdFAI)

Instructions: This form will be used to categorize your ankle stability status. A separate form should be used for the right and left ankles. Please fill out the form completely and if you have any questions, please ask the administrator. Thank you for your participation.

Please carefully read the following statement:
“Giving way” is described as a temporary uncontrollable sensation of instability or rolling over of one’s ankle.

I am completing this form for my RIGHT/LEFT ankle (circle one).

1.) Approximately how many times have you sprained your ankle? ____

2.) When was the last time you sprained your ankle?

- Never
- > 2 years
- 1-2 years
- 6-12 months
- 1-6 months
- < 1 month

3.) If you have seen an athletic trainer, physician, or healthcare provider how did he/she categorize your most serious ankle sprain?

- Have not seen someone
- Mild (Grade I)
- Moderate (Grade II)
- Severe (Grade III)

4.) If you have ever used crutches, or other device, due to an ankle sprain how long did you use it?

- Never used a device
- 1-3 days
- 4-7 days
- 1-2 weeks
- 2-3 weeks
- > 3 weeks

5.) When was the last time you had “giving way” in your ankle?

- Never
- > 2 years
- 1-2 years
- 6-12 months
- 1-6 months
- < 1 month

6.) How often does the “giving way” sensation occur in your ankle?

- Never
- Once a year
- Once a month
- Once a week
- Once a day

7.) Typically when you start to roll over (or ‘twist’) on your ankle can you stop it?

- Never rolled over
- Immediately
- Sometimes
- Unable to stop it

8.) Following a typical incident of your ankle rolling over, how soon does it return to ‘normal’?

- Never rolled over
- Immediately
- < 1 day
- 1-2 days
- > 2 days

9.) During “Activities of daily life” how often does your ankle feel UNSTABLE?

- Never
- Once a year
- Once a month
- Once a week
- Once a day

10.) During “Sport/or recreational activities” how often does your ankle feel UNSTABLE?

- Never
- Once a year
- Once a month
- Once a week
- Once a day

Version 1.0
IdFAI Scoring Sheet:

IDENTIFICATION OF FUNCTIONAL ANKLE INSTABILITY (IdFAI)

Instructions: This form will be used to categorize your ankle stability status. A separate form should be used for the right and left ankles. Please fill out the form completely and if you have any questions, please ask the administrator. Thank you for your participation.

Please carefully read the following statement:
"Giving way" is described as a temporary uncontrollable sensation of instability or rolling over of one's ankle.

I am completing this form for my RIGHT/LEFT ankle (circle one).

1.) Approximately how many times have you sprained your ankle? _______

2.) When was the last time you sprained your ankle?

- Never
- > 2 years
- 1-2 years
- 6-12 months
- 1-5 months
- < 1 month

3.) If you have seen an athletic trainer, physician, or healthcare provider how did he/she categorize your most serious ankle sprain?

- Have not seen someone
- Mild (Grade I)
- Moderate (Grade II)
- Severe (Grade III)

4.) If you have ever used crutches, or other device, due to an ankle sprain how long did you use it?

- Never used a device
- 1-3 days
- 4-7 days
- 1-2 weeks
- 2-3 weeks
- >3 weeks

5.) When was the last time you had "giving way" in your ankle?

- Never
- > 2 years
- 1-2 years
- 6-12 months
- 1-6 months
- < 1 month

6.) How often does the "giving way" sensation occur in your ankle?

- Never
- Once a year
- Once a month
- Once a week
- Once a day

7.) Typically when you start to roll over (or 'twist') on your ankle can you stop it?

- Never rolled over
- Immediately
- Sometimes
- Unable to stop it

8.) Following a typical incident of your ankle rolling over, how soon does it return to 'normal'?

- Never rolled over
- Immediately
- <1 day
- 1-2 days
- >2 days

9.) During "Activities of daily life" how often does your ankle feel UNSTABLE?

- Never
- Once a year
- Once a month
- Once a week
- Once a day

10.) During "Sport/or recreational activities" how often does your ankle feel UNSTABLE?

- Never
- Once a year
- Once a month
- Once a week
- Once a day

Version 1.0
APPENDIX E

POWER ANALYSIS
Peak Plantar Pressure


First Metatarsal Head Pressure between Controls and Ankle Instability groups

\[
\frac{(1.05-0.76)}{\frac{(0.70+0.47)}{2}} = 0.49
\]

Third Metatarsal Head Pressure between Controls and Ankle Instability groups

\[
\frac{(1.54-0.96)}{\frac{(0.68+0.51)}{2}} = 0.97
\]

Average = \(\frac{(0.49+0.97)}{2} = 0.73\) \(\approx\) sample size of 26


Midfoot Pressure between Controls and Ankle Instability groups

\[
\frac{(0.207-0.158)}{\frac{(0.089+0.07)}{2}} = 0.616
\]

Lateral Forefoot Pressure between Controls and Ankle Instability groups

\[
\frac{(0.224-0.0269)}{\frac{(0.065+0.068)}{2}} = 2.96
\]

Average = \(\frac{(0.616+2.96)}{2} = 1.788\) \(\approx\) sample size of 15

Power = 0.80

Alpha = 0.05

Arch Index

*There were no known studies on Functional Ankle Instability using Arch Index as a dependent variable. Therefore for comparison, an alternate pathology is used below.*


PFS = plantar fasciitis symptoms, PFH = plantar fasciitis history

Controls vs PFS

\[
\frac{(0.22-0.17)}{\frac{(0.05+0.08)}{2}} = 0.769
\]

Controls vs PFH

\[
\frac{(0.22-0.17)}{\frac{(0.05+0.07)}{2}} = 0.833
\]

Average = \(\frac{(0.769+0.833)}{2} = 0.801\) \(\approx\) sample size of 20

Power = 0.80

Alpha = 0.05

For this study, I propose the need for 20 subjects per group.